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Introduction to WTC & Workspaces 
Any user from anywhere in the world who has a computer with Internet browser or FTP client can access EFT 
and share files—provided the computer on which the user is attempting to connect to EFT is allowed access, 
and the user has an account defined on EFT. The user account itself or the group to which it belongs must 
have the appropriate permissions (upload, download, create folders, and so on) assigned on the VFS tab of the 
administration interface. When users log in to EFT, they connect only to their home folders and cannot 
browse above their home folders. 

EFT allows the following methods through which you can share files using EFT: 

• Workspaces - Users (with a Workspaces license) can share files and folders with other EFT users 
through the Web Transfer Client. Additionally, if the EFT administrator allows it, you can share files 
with external users and share your Workspaces folders. 

• EFT Outlook Add-In - With the EFT Outlook Add-In, users can send files via email and the 
recipient can pick them up in their web browser through Workspaces. 

• Web Transfer Client (WTC) - The WTC is a browser-based file transfer client that allows users to 
transfer files over HTTP or HTTPS. The WTC can resume transfers and can send multiple files 
concurrently. It also has drag-and-drop support, integrity validation, a transfer queue, and no file-size 
limit. The number of files a directory listing can contain, the characters a file/folder name can contain, 
and the path length of directories is limited by Windows conventions. Refer to File-Naming 
Conventions for details. 

• If the user is trying to connect to the WTC with an older, unsupported browser, a "plain text" 
client (shown below) appears instead of the WTC. 

• If the administrator has not enabled the WTC for a Settings Template or user account, a 
"plain text" client appears instead of the WTC. 
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• Globalscape's CuteFTP® or a similar "FTP client" - Any FTP client can be used to connect to EFT 
and transfer files. For more information about CuteFTP, refer to 
https://www.globalscape.com/cuteftp or online help. 

• Windows Explorer - When logged in to the EFT computer, administrators can manage files on EFT 
using Windows Explorer. By default, user files are stored in the C:\Inetpub\EFTRoot\ folder in the 
Usr folder under the Site on which their account is defined (or, on HA implementations, in the shared 
configuration path, e.g., \\x.x.x.x\inetpub\EFTRoot\mySite\Usr\username). In the illustration 
below, user imauser, defined on GSSite, stores files in the imauser folder. Anyone with the proper 
permissions on the EFT computer can drag and drop, copy and paste, and create and delete files and 
folders, just like in Windows Explorer. For example, suppose user imauser has gone over her quota 
and can no longer upload any files. Instead of increasing the quota for the folder, you can delete files 
from the imauser folder that imauser no longer wants, or move them to some other accessible 
storage. 

 
• Command Prompt - At a command prompt, you can enable an FTP session and transfer files, if you 

are familiar with basic DOS commands. Refer to the KB article "Can I use a Windows Command 
Prompt to send FTP commands to a server?" for list of common commands.  

WTC & Workspaces Administration 
Workspaces extends the secure and robust EFT file transfer platform with features that allow end users to 
easily share folders with existing and new user accounts, without burdening the IT administrator. Workspaces 
empowers end users to share folders quickly and easily, while IT administrators retain full control and visibility 
of the file transfer infrastructure, leveraging the highest levels of security, regulatory compliance, flexible 
authentication, and data encryption aspects of the EFT platform. No file sync and share vendors have the 
underlying security features empowered by EFT for Workspaces as a sharing solution (DMZ Gateway, 
multiple secure protocols, workflow automation, flexible authentication, etc.). 

https://www.globalscape.com/cuteftp
https://help.globalscape.com/help/cuteftp9/
https://kb.globalscape.com/KnowledgebaseArticle10407.aspx
https://kb.globalscape.com/KnowledgebaseArticle10407.aspx
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Administrators Retain Control 

IT Administrators are able to delegate to end users the power of managing shared folders with existing and 
new users without losing governance, visibility, and control. End users are given a tool that fulfills the 
workflows they have become used to (online file sharing) in a way that conforms to corporate policy. 
Workspaces gives IT administrators the freedom to deny access to cloud-based file sharing services within 
their organization, because they have provided a safe alternative to their internal customers. 

When a user's folders are shared, via the Web Transfer Client, the shared folder appears in the EFT 
administration interface on the VFS tab under the Workspace node. 

Here, the administrator can see: 

• With whom the folder is shared 

• What the permissions are on each user account 

• When the Workspace was created 

• The physical path to the folder 

• Who owns the folder 

The administrator can also add or remove specific permissions on the folder for each participant. 

Workspaces Licenses 

During the EFT 30-day trial, you can have up to 100 Workspaces owners (creators). You can allow or deny 
Workspaces creation to specific users. 
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o After a guest has been invited to join a Workspace and has created an account and logged in, 

the guest account will appear (if so configured) in the Guest Users Settings Template. In EFT 
versions prior to 7.4.7, this account will consume a Workspaces licenses until you disallow the 
creation of Workspaces on that account or in the Settings Template.  

 

A Workspaces license is consumed for each Drop-off portal message no matter how 
many recipients the message has. A license is not consumed on replies. A license is not 
consumed on Send Portal messages. You can avoid Workspaces licenses being consumed by 
the Drop-off portal by disabling the Drop-off portal. It is not enabled by default. 

When someone uses the drop-off portal, that "someone" becomes a "Workspaces owner." 
This is because behind the scenes, a temporary, anonymous account is created to host the 
Workspace, thus consuming a license (assigned to that account). Once the space expires, the 
anonymous account is also removed, and the license is released to the pool.  
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• The Site's General tab displays how many licenses are consumed (assigned) and how many remain. 
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Workspaces are viewed and created in the Web Transfer Client (WTC); therefore, if a user does not have 
access to the Web Transfer Client, the user cannot create or access a shared Workspace. If the user cannot 
access the WTC, the "plain text client" (PTC) appears when the user logs in. 

 
Workspaces Licensing versus Web Transfer Client Licensing 

Workspaces are viewed and created in the Web Transfer Client (WTC); therefore, if a user does not have 
access to the Web Transfer Client, the user cannot create or access a shared Workspace. If the user cannot 
access the WTC, the "plain text client" (PTC) appears when the user logs in. 

The flowchart below describes what occurs when a user logs in to EFT in a browser. 

 
Allow Secure File Sending 

Using Workspaces in the WTC and in Outlook, you can send files securely, and your recipients can reply to 
you securely. Before users can send the message body securely, you must first enable secure file sending on 
the Workspaces - Send tab and the Settings Template or User account must have Allow secure file sending 
enabled.  
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Conceal WTC and Its Content from Searches 

The WTC/Workspaces pages and content is visible to Web searches. A file named robots.txt on the server 
tells web crawling robots whether to ignore the site. You can create a registry key to prevent 
WTC/Workspaces pages and content from appearing in search results.  In EFT, the robots.txt file is located 
(by default) in C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient. 

To enable or disable searches 

1. Create the following registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\GlobalSCAPE Inc.\EFT Server 7.4\ 

2. Add a DWORD and name it ServeRobotsFile 

3. Set the DWORD to 0 (disabled, the default) or 1 (enabled) 

4. Restart the EFT server service. 

The EFT.log file indicates that the key was read in at startup. (the first log is initial startup, 0, the second one is 
after changing it to 1 and then restarting the service: 

09-27-17 15:08:26,526 [2992] INFO AdvancedProperties <> - 
HKEY_LOCAL_MACHINE\SOFTWARE\GlobalSCAPE Inc.\EFT Server 7.4\ServeRobotsFile=0 
09-27-17 15:57:26,913 [1096] INFO AdvancedProperties <> - 
HKEY_LOCAL_MACHINE\SOFTWARE\GlobalSCAPE Inc.\EFT Server 7.4\ServeRobotsFile=1 

 

Customizing WTC 

Guest User registration in the Web Transfer Client has been updated to provide a simpler registration process. 
You can change the "atom" graphic on the registration page to your company logo, and change the colors 
around the username and password boxes to fit your company style guide. If you are familiar with editing 
JavaScript, you can customize other things. Each of the JavaScript files are saved in C:\Program Files 
(x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\shadowfax\reg\assets\.  

 

Please make a backup copy of any files that you plan to edit, in case you have to back out your edits.  
Do not attempt to make changes to the JS or PS files unless you are well version in doing so. If you need help, 
you can engage Globalscape Professional Services to make customizations. 

To change the atom logo 

1. Create or copy your logo to the EFT computer. 

2. In C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\shadowfax\reg\assets\images, rename wtc-atom.png to wtc-
atom-OLD.png. 

3. Paste your new logo into the same folder, then rename the new logo to wtc-atom.png. 

4. Open (or restart) the browser page to update it. If the logo does not update, you may need to clear 
the browser cache. 

https://www.globalscape.com/contact-pro-services
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To change the Password and Confirm Password box colors 

By default, the Password and Confirm Password boxes are blue, and then change to red if there is an error 
(e.g., the email that was typed is not in the correct format). To change those colors, you must edit the 
theme.json file and then run the PowerShell script, customize-theme.ps1, in C:\Program Files 
(x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\shadowfax\reg\assets\customization.  

1. Edit theme.json in a text editor such as Notepad or WordPad. 

2. Open Windows PowerShell ISE (click Start, then Search to find it). 

3. In PowerShell, open customize-theme.ps1, then click the Run icon. 

4. Go to your WTC address (e.g., https:\\mywtc), then click Forgot Password to open the forgot-
username window. The text-entry boxes should be displayed in your new colors. 

Language and Browser Settings 

The registration page will attempt to detect the user's language stored in the browser's settings, if a supported 
language (Spanish, French, Dutch, and German) is detected. If the language is not detected, the page will 
default to English. Or, on the registration page, you can click the English drop-down to choose other 
supported languages.  

For example, in Google Chrome: 

1. Go to Settings > Advanced Settings > Languages. 

2. Click Language. The Language box expands. 

 
3. Click Add languages, select the check box of one or more languages that you want to use, then click 

Add. (Note: Unless you use Google Sync, you will need to do this on each computer that you use.)  

4. If you are using more than one language, you can specify which language is the default by moving it to 
the top of the list. Click the three dots to the right of the preferred language, and then click Move to 
the top. 



15 

5. Click other settings as desired. Your changes are saved automatically. 

In Internet Explorer, you must disable Compatibility View (clear the check box). All other browsers display 
correctly. 

In Internet Explorer, click Menu > Tools > Compatibility View. (If the File Menu is not displayed, press the 
ALT key.) 

 
Disable CRC 

The Web Transfer Client (WTC) can validate the integrity of files transferred to and from EFT. Cyclical 
Redundancy Check (CRC32) is enabled on the WTC by default. The EFT administrator must have enabled 
CRC in its FTP configuration to take advantage of this feature. 

With CRC enabled, when the WTC transfers a file to or from EFT, it automatically queries EFT for the CRC 
value of the file, then compares it to the CRC value for the local file. If they match, the transfer is reported as 
successful. If they do not match, the system reports a "CRC Failure." The user can then retry the transfer, if 
necessary. The client does not automatically retry the transfer if they do not match. 

If upload verifications are not required, you can disable CRC in the WTC configuration file. 



16 

 

The HTML5 version of the Web Transfer Client does not support a CRC-check for downloaded files because of 
the limited access of html/js to the client file system. The process of initiating a download is human driven and can 
NOT be intercepted by a JavaScript API; it is wholly managed by the browser itself, for security reasons. Further, 
the browser cannot arbitrarily read files on the local file system (for obvious security reasons), so EFT cannot 
read contents of downloaded files to do CRC32, and thus cannot issue a follow-up HEAD request to verify the 
integrity of the download. 

To disable CRC 

1. In C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\jument\scripts, find the adminConfig.js file. (There is a number 
in front of the name.) 

2. Open the configuration file in a text editor, such as Notepad++. (It may be necessary to change the 
extension from JS to TXT to view it properly.) 

3. At the very bottom of the file, find the following text: 
gsb.config.crcVerifications = true; 

4. Change true to false, then save the file. 

5. If you changed the name of the file to edit it, be sure to change it back. 

6. Now transfers will be processed without CRC. 

  

Disabling "Update Your Browser" Prompts 

If end users do not have the necessary permissions to install an updated browser that supports certain features 
(such as folder uploads in Internet Explorer), administrators can enable a prompt that tells the user to update 
the browser, similar to the following prompt: 

 
To disable prompts 

1. In the /scripts/ folder, open adminConfig.js (in the format of 
HHHHHHHH.adminConfig.js, where H is a hex value) in a text editor. The file contains 
JavaScript similar to the following text: 

'use strict'; 
/* global gsb */ 
gsb.config.disableSiteInitPopups = false; 

https://notepad-plus-plus.org/download/v6.8.3.html


17 

2. Edit the last line to change it from false to true: 
gsb.config.disableSiteInitPopups = false; 

3. Save changes to the file. 

Display Full Name of User in WTC on LDAP Site 

In the Web Transfer Client (WTC), you can display the full name of a user instead of the username by creating 
the registry setting described below. 

(Workspaces much be enabled to display the full user name in the WTC.) 
HKEY_LOCAL_MACHINE\Software\WOW6432Node\GlobalSCAPE Inc.\EFT Server 7.4\ 

Type: DWORD 

Value name: DisplayUserFullNameInJument 

Default Value: 1 

Cached: yes 

Backup/Restore: yes 

Enabling User Access to the Web Transfer Client 

(Requires the HTTP/S module in EFT SMB/Express) Before users can log in to EFT using the Web 
Transfer Client (WTC), EFT administrator must configure EFT to allow connections from the WTC. Active 
Directory domain users must have logon permission on EFT computer in order to log on to EFT through the 
WTC. This is accomplished by adding AD domain users to the "Allow log on locally" list on EFT computer. If an 
AD domain user is not in this list, logging on to EFT through the WTC will fail and an error message appears 
informing the user that Local login access is required to log on to EFT. 

 

Stopping and restarting the Site disconnects everybody who is connected; users must log back in. 

To configure EFT to allow Web Transfer Client Connections 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Settings Template or user account. 

3. In the right pane, click the Connections tab. 
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4. In the Protocols area, select the Allow Web Transfer Client over HTTP/S check box. 

 

HTTPS must also be enabled. 

5. Click Apply. 

Enable and Configure EFT Workspaces 

The Workspaces feature of EFT allows end users to share their folders with other users. The user account that 
is sharing the folder maintains control of permissions to the shared folder, and can revoke sharing privileges at 
any time. 

Workspaces provides the ability to easily share and collaborate on information that is securely managed by 
EFT, including existing authentication, access control, auditing, governance, and Event Rule workflow 
capabilities available in EFT. 

Refer to Licensing Workspaces for important information regarding Guest Accounts. 

To enable Workspaces 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 
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3. In the right pane, click the Workspaces tab. 

 
4. Select the Enable Workspaces check box. The Guest Accounts Settings Template appears under 

User Settings Templates. 

5. Under Workspaces Configuration, specify whether to allow EFT users to send invitations to users 
not in the EFT user authentication database. 

o Allow invitations to new EFT users for Workspaces 

 (Optional) Specify the domains to which Workspaces users can send invitations, 
comma/semicolon delimited. Wildcards are supported (e.g., *.domain.com or 
domain.com). The setting is not selected by default; that is, all domains *.* are 
allowed. (Allow invitations to new EFT users for Workspaces must be selected.) 
NOTE: Be sure wildcards are formatted correctly. That is, if you have specified 
*.domain.com, then the domain www.domain.com is allowed. 

o Allow Workspaces shared with existing EFT users only 

 On an LDAP-authenticated Site, when a sender types a recipient email to share a 
Workspace, if that email does not belong to a local (cached) account in EFT, EFT 
will extend its search to the LDAP authentication database.   

6. Specify the maximum expiration period for a Workspace. Senders can set the expiration to happen 
sooner than what is defined on the server, but you cannot specify a longer period. 
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7. Under Guest Account Controls: 

o Specify whether to Disable account, Remove account and home folder, or Remove 
account only after all Workspaces links have expired and n days have passed. When set to 0 
days, the account(s) will be cleaned up at midnight. If the Guest Account is disabled, the user 
will not be able to log in unless the EFT administrator enables or removes the account (and 
then the guest user would have to recreate their account). 

o To grant guest users their own home folder, select the Grant each guest user their own 
folder check box. Selecting the check box prevents guests from viewing other files in the 
Workspace's home folder. If the check box is not selected, the user has: 

 Read-only access to home folder. 

 List view of Workspaces with permissions as allowed by w/s owner, regardless of any 
protocols used to access the account. 

8. Click Apply to save the settings. 

To enable Workspaces for specific users 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Settings Template or user account. 

3. In the right pane, click the Connections tab. 
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4. In the Protocols area, select the Allow Creation of Workspaces check box. If this check box is not 

available, you have not activated the Workspaces licenses or the trial has expired; or you have not 
enabled Workspaces for the Site. 

 

HTTPS must also be enabled. 

5. To also allow the use of the Outlook add-in, ensure that the Allow secure file sending check box is 
selected. 

6. Click Apply. 
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Enable Workspaces to Send Files 

Workspaces for Outlook is an enterprise ad hoc file transfer solution that allows employees to quickly and 
securely send large files right from within Microsoft Outlook. Workspaces for Outlook allows organizations to 
address broad scale, risky file sharing practices while providing an easy-to-use interface for end users that 
requires little to no training from IT staff. Users can quickly and easily send large files via email from within 
Microsoft Outlook via the dedicated add-in, and benefit from an enhanced email experience with advance 
sending features, such as the ability to receive file pick up receipts. Recipients pickup their files in their web 
browser via a secure link. Administrators have the ability to manage user transactions behind the scenes, 
including the ability to set secure link expiration overrides and set policies for the automatic handling of 
exceedingly large file attachments.   

• Before using this feature, the EFT administrator must enable Workspaces and install and enable the 
EFT Outlook Add-In, as described below. 

• When you send a file using the WTC, a WorkspacesSendMessage folder is created under the 
sending user's home folder in the Virtual File System (VFS). Subfolders in the 
WorkspacesSendMessage folder are named for the Subject line of the message. 

 
To enable Workspaces for Outlook 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. In the right pane, click the Workspaces tab. 

4. Select the Enable Workspaces check box, then click Apply. 

• To configure Workspaces, select the Enable secure file sending check box. 
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5. Under Authorized users can send files to, select one of the following options: 

• Existing EFT users only (most restrictive) - Allows EFT users to send files via Workspaces 
for Outlook only to other users with an EFT account 

• Existing EFT user and registered guest accounts - Allows EFT users to send files via 
Workspaces for Outlook to other EFT user accounts and registered guest accounts 

• Existing EFT users, registered guest accounts, and anonymous users - Allows EFT users 
to send files via Workspaces for Outlook to other EFT user accounts, registered guest 
accounts, and non-EFT user accounts. Non-EFT user accounts do not require credentials, 
making it easy for the recipient to pick up files, but makes the system less secure. To reduce 
this risk, the sender can make the pickup link "single use." 

 Transactional Workspaces folders in the VFS that are shared with unregistered users 
will have an exclamation point on the anonymous-access folder 

6. In the Send portal reserved path box, specify the path for the Send portal. The default is /send. 

7. In the Hostname:port box, specify the URL for file pick up. 

8. To require the use of Outlook for large files, select the Auto-attach files in Outlook when they 
exceed check box, and then specify a size. 

9. Specify the maximum expiration period for pickup links. The default is 1 month. 

10. Do one of the following to deploy the EFT Outlook add-in on end-users' computers: 

• Use the EFT Outlook add-in installer: 
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 Click Browse to open the EFT installation folder, get the EFT Outlook add-in 
installer, and install the EFT Outlook Add-In as described in Installing the EFT 
Outlook Add-In. 

-OR- 

• Use the Outlook add-in deployment script: 

a. Click View to open the Outlook Add-in Deployment Script box. 

b. Copy and paste the script into the tool you are using to deploy the Outlook Add-In 
across your organization. 

c. Click OK or press ENTER to close the Outlook Add-in Deployment Script box. 

d. Edit the script to match your environment (i.e., the EFTHOST IP address and port, 
username, password). 

EFT supports Manual authentication, which is really Basic authentication, so you have 
to explicitly provide the user's EFT username and password (that is, the username and 
password that this Add-In user uses to log in to EFT--not the admin credentials). EFT 
also supports Integrated Windows Authentication (IWA) where you don’t have to 
explicitly provide a username and password if you are logged into Windows with your 
domain account. 

Edit the Add-In installer command-line arguments depending on the authentication 
type you want: 

• For manual authentication, do the following (EFTUSERNAME and 
EFTPASSWORD values have to be substituted with the actual Add-in user’s EFT 
username and password): 

msiexec /lv installation.log /qn /i EFTOutlookAddinInstaller.msi 
EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 EFTAUTHTYPE=MANUAL EFTUSERNAME=username 
EFTPASSWORD=test123! INSTALLLOCATION="%userprofile%\AppData\Roam
ing\GlobalSCAPE\EFT Outlook Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\GlobalSCAPE\EFT 
Outlook Add-in" 

• For Integrated Windows authentication, do the following (EFTUSERNAME and 
EFTPASSWORD don’t need to be supplied): 

msiexec /lv installation.log /qn /i EFTOutlookAddinInstaller.msi 
EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 EFTAUTHTYPE=IWA INSTALLLOCATION="%userpr
ofile%\AppData\Roaming\GlobalSCAPE\EFT Outlook Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\GlobalSCAPE\EFT 
Outlook Add-in" 
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Enable-Disable Workspaces Reply Portal 

After a recipient has received a message sent through Workspaces, the recipient can reply to the email in the 
Workspaces Reply Portal (if so configured) and send files back to the sender. If you do not want to allow that 
functionality, you can disable the Reply portal. It is enabled by default. 

 

Disabling the Reply portal removes the Request File(s) functionality from the Web Transfer Client interface. 

To enable or disable the reply portal 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. In the right pane, click the Workspaces-Send tab. 

4. Select or clear the Enable reply portal check box, then click Apply. 

 
5. Click Apply. 

Enable and Configure the Workspaces - Drop-Off Portal 

The Workspace Drop-Off portal allows employees and partners to send files to internal users, with no 
attachment limits. The transfer of the email and attachments is encrypted and secure. The Drop-Off portal is 
configured at the Site level and the Workspaces - Drop Off tab. 

 

A Workspaces license is consumed for each Drop-off portal message no matter how many recipients the 
message has. A license is not consumed on replies. A license is not consumed on Send Portal messages. You can 
avoid Workspaces licenses being consumed by the Drop-off portal by disabling the Drop-off portal. It is not 
enabled by default. 
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When someone uses the drop-off portal, that "someone" becomes a "Workspaces owner." This is because behind 
the scenes, a temporary, anonymous account is created to host the Workspace, thus consuming a license 
(assigned to that account). A folder, named with the Subject line of the email, appears under the anonymous 
folder in the VFS. Once the space expires, the anonymous account is also removed, and the license is released to 
the pool.  

 

For additional security, you can configure Google's reCAPTHA on the Site, as described below. 

To enable the Drop-Off portal 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. Ensure that Workspaces and secure file sending is enabled and configured. 

4. In the right pane, click the Workspaces - Drop-Off tab. 
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5. Select the Enable the "drop-off" portal check box. 

6. Specify a portal reserved path if you want something different from the default (/dropoff). 

7. (Optional) To use captcha, select the Enable reCAPTCHA check box. 

a. Specify whether to use Standard CAPTCHA or Google reCAPTCHA. 

b. If you click Google reCAPTCHA, refer to the reCAPTCHA procedure below, then specify 
the following keys: 

• In the Site Key box, paste the Google Site Key. 

• In the Secret Key box, paste the Google Secret Key. 

8. In the Expire pick-up links after boxes, specify the number of Days, Weeks, Months, or Years 
before a pick-up link expires. Be aware that using the Drop-Off portal consumes a Workspaces 
license, which is not released until the link expires. The default expiration is 1 month. 
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9. (Optional) Specify the Maximum message size. 

 

If the Maximum message size check box is not selected, the maximum message size is 3 GB. 
Knowledgebase article #11389 describes a registry setting that you can use to set the maximum 
anonymous uploads size in GB. If the "MaxAnonymousAllUploadsSizeInGB" value in the registry is set 
to a value that is LESS than Maximum message size on the Workspaces - Drop-Off tab, an error 
occurs stating that the file is too large. 

10. Specify the Secure the message body setting: Always secure, Never secure, or User Choice. User 
choice is the default. 

11. (Optional) Specify whether to allow users to enter a To email address. 

• If you are allowing users to enter a To email address, specify which domains are allowed. If 
you leave the box blank, you have an "open-relay" server, which is not recommended. 
Suggested domains include your organizational domain(s) and other necessary domains. 

11. In the Address Book, add one or more addresses and aliases that will appear in the To field. 

• The Alias that you define in the address book will appear in the To box in the Drop-Off 
portal. Having the alias avoids leaving the complete email address exposed. This is useful in 
cases such as if you are mailing a PDF form to multiple clients who might not want you to 
share their email address with everyone. 

12. Click Apply. 

To configure reCAPTCHA for the Drop-Off portal 

1. If you want to enable CAPTCHA, before you enable and configure the Drop-Off portal, go to 
https://www.google.com/recaptcha/admin and log in to your Google account. 

https://kb.globalscape.com/KnowledgebaseArticle11389.aspx
https://www.google.com/recaptcha/admin


29 

 
2. Click reCAPTCHA v2. The Domains box appears. 
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3. In the Domains box, type one or domains (Sites) that are to use reCAPTCHA. 

4. Select the Terms of Service check box. 

5. Click Register. The keys appear. 

 
6. Save the Site key and Secret key. You will need these to configure the Drop-Off portal in EFT if you 

are enabling CAPTCHA. 

Guest Users 

After a guest (non-EFT user) has been invited to join a Workspace, has created an account, and logged in, the 
guest account will appear (if so configured) in the Guest Users Settings template. The Guest Users Settings 
Template appears when Workspaces is enabled. 

After the Workspace has expired, the guest account is either disabled or removed, depending on the settings 
on the Workspaces tab. If the guest account is disabled, the EFT admin must remove it or enable it before 
they can receive any Workspaces invitations. 
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Guest users' permissions depend on what the EFT administrator configures in the Guest Users Settings 
Template. The default settings include Download, Show this folder in parent list, Show files and folders in 
list. Users with whom a Workspace is shared do NOT have permission to move files and folders out of the 
Workspace. 

 
Login to EFT (WTC) 

The EFT administrator should inform end users which IP address, port, username, and password should be 
used to log in to a Site. Because many users are unfamiliar with <IP address:Port> formatting, be sure to 
provide users with the exact URL that they should access to log in, whether they are accessing a Site from the 
Web Transfer Client, "plain-text" client, a command line, CuteFTP, or any other FTP client. For example, you 
could provide a link in an e-mail or tell your users: 

In the address box of Internet Explorer, type https://wtc.mycompany.com:4434 

To log in to EFT to transfer files 

1. Open a web browser to the address provided by the EFT administrator. For example, 
https://mycompany.com/EFTClient/Account/Login.htm. The login page appears. 

2. Provide your EFT Username and Password, and then click Log In. 

• If you have forgotten your username or password, click the applicable link. You will be asked 
for your email address to which the reset information will be sent. 

• If the Web Transfer Client is not enabled, a less-featured version of the WTC appears. 

• If it is configured in the EFT administration interface, users are prompted to change their 
password the first time they log in. 
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• If a security prompt appears asking you to accept the website's certificate, select the Always 
trust check box, and then click Yes. 

3. Refer to Web Transfer Client (WTC) for details of transferring files. 

Form-Based Authentication versus Basic Authentication 

(Requires the HTTP/S module in EFT Express) 

EFT uses form-based authentication for users that connect over a browser. It is important to note that a 
browser is defined merely by what is contained in the "user-agent" attribute provided in the HTTP headers. If 
EFT doesn’t recognize the user-agent (such as when connecting with a client application CuteFTP), then EFT 
will fall back to "basic authentication." There is nothing inherently wrong with basic authentication, especially if 
it is SSL encrypted, but form-based is considered superior because it facilitates true session management. 
However, there is another option, which is NTLM authentication, in which EFT attempts to reuse the user’s 
AD credentials as supplied by the browser (assuming the browser supports NTLM), resulting in a single-sign-
on (SSO) experience. For example, the user authenticates on the company portal, and those credentials are 
reused by EFT without having to ask the user to re-enter them. The downside to NTLM-based authentication 
is that, like basic authentication, it does not support true sessions, so it is up to the users to close their 
browsers at the end of their sessions to truly log out. Another drawback is that when using NTLM, the end 
user won’t be able to choose between loading the Web Transfer Client or the Plain Text Client, won’t be able 
to access the lost username/password forms, and won’t see any of the custom branding. Each of these would 
be available to the user if they had used the default form-based authentication. Even in the case where NTLM 
is enabled, SSO will only apply for Active Directory-based sites (because we are talking about AD 
credentials), and the browser has to be a recognizable user-agent; otherwise, it will default to basic 
authentication (for non-browser) or form-based authentication (for non-AD sites), even if NTLM is turned 
on in the registry.   

• If NTLM is off (by default), then EFT will use form-based authentication for recognized user-agents 
and basic-authentication for all others 

• If NTLM is on (registry enabled), then EFT will use NTLM authentication for AD sites + recognized 
user-agent, form based authentication for non-AD sites + recognized user agent, and basic 
authentication for all others (non-recognized user agents). 

Managing Workspaces in the VFS 

The VFS tab has a Workspaces view in which EFT Server- and Site-level administrators can: 

• Delete shared Workspaces 

• Add existing users to existing Workspaces 

• Modify participant permissions of shared Workspaces 

• When you send a file using the WTC, a "WorkspacesSendMessage" folder is created in the Virtual File 
System (VFS). 

https://kb.globalscape.com/KnowledgebaseArticle11035.aspx
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Sharing folders via the VFS tab 

• Workspaces cannot be created via the VFS tab. 

• External users cannot be invited via the VFS tab. External users can only be invited via the WTC. 

• Users joined to Workspaces via the VFS tab, unlike users joined via WTC, are not sent invitation 
notification emails. 

• Workspaces permissions may be granted via the VFS Workspaces view, however, the permissions 
may not be permitted. The VFS tab will appear to permit all user permissions to be granted to a 
Workspaces participant, however, the available permissions extend from the Workspaces owner's 
folder permissions. Suppose an EFT user creates a shared folder with only Upload permissions; an 
EFT administrator may invite participant1 to join the Workspaces folder, granting participant1 full 
administrative privileges to the folder. However, participant1 will receive an "access denied" response 
if they attempt to perform any actions within the folder other than upload, because the Workspaces 
folder respects the Workspaces owner's folder permissions. 

 
Restrict Workspaces Invitations to Specific Domains 

Administrators can configure Workspaces so that only specific domains can be invited to access a Workspace. 

To restrict Workspaces invitations 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. In the right pane, click the Workspaces tab. 
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4. Under Workspaces Configuration, select the Allow invitations only to these domains check box, 

then specify the domain(s) in the text box, comma/semicolon delimited. Wildcards are supported 
(e.g., *.cisco.com or cisco.* or *.*). The setting is not selected by default. (Allow invitations to new 
EFT users for Workspaces must be selected.) 

5. Click Apply. 

  

Terms and Conditions 

Web Transfer Client (HTML5 version) users can be asked to accept or decline a Terms and Conditions page 
before continuing to the WTC. It is not available by default. 

To enable the Terms and Conditions page 

1. Copy the \EFTClient\ folder from \web\public\ to \web\custom\. (Refer to Customizing the WTC 
for information about customizations.) 

2. Create a file names terms.html. 

3. Save the file in \web\custom\EFTClient\jument. 

To view an example Terms and Conditions file, right-click terms.txt, and then click Save As. You may use this 
example for your Terms and Conditions page, making sure to review and revise for your company. Be sure to 
save the file as terms.html in the appropriate folder as explained above. 
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When creating your terms.html file, you do not need the <html> and <body> tags, because the file will be 
inserted into a frame in the WTC. You do, however, need to use HTML tags for formatting things like 
headings, paragraphs, and quotation marks, as shown below: 

<h3>Web Transfer Client Terms and Conditions</h3> 

<p> In using this website you are deemed to have read and agreed to 
the following terms and conditions:</p> 

<p> The following terminology applies to these Terms and Conditions, 
Privacy Statement and Disclaimer Notice and any or all Agreements: 
&quot;Client&quot;, &ldquo;You&rdquo; and &ldquo;Your&rdquo; refers to 
you, the person accessing this website and accepting the 
Company&rsquo;s terms and conditions. &quot;The Company&quot;, 
&ldquo;Ourselves&rdquo;, &ldquo;We&rdquo; and &quot;Us&quot;, refers 
to our Company. &ldquo;Party&rdquo;, &ldquo;Parties&rdquo;, or 
&ldquo;Us&rdquo;, refers to both the Client and ourselves, or either 
the Client or ourselves. All terms refer to the offer, acceptance and 
consideration of payment necessary to undertake the process of our 
assistance to the Client in the most appropriate manner, whether by 
formal meetings of a fixed duration, or any other means, for the 
express purpose of meeting the Client&rsquo;s needs in respect of 
provision of the Company&rsquo;s stated services/products, in 
accordance with and subject to, prevailing English Law. Any use of the 
above terminology or other words in the singular, plural, 
capitalization and/or he/she or they, are taken as interchangeable and 
therefore as referring to same.</p> 

<h4> Privacy Statement</h4> 

If you are not familiar with HTML code, Globalscape's Professional Services team offers a range of 
professional services to complement your product solution. 

Transactional Workspaces 

A Transactional Workspaces is a special kind of Workspace that results from sending a file for pick up from the 
EFT Outlook Add-In or Drop-Off portal. The recipient only has download permission on the file(s) received. 
Transactional Workspace participants cannot see each other and cannot subscribe to notifications. 

https://www.globalscape.com/pro-services
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This Workspace is different from normal Workspaces in that a Transactional Workspace: 

• Accepts anonymous access, if the administrator allows it and the owner/sender chooses 

o Contains folders in the VFS that have been shared via public links (unregistered users) and 
have an exclamation point on the anonymous-access folder 

• Grants permission to download only 

• Can't have participants added post creation 

• Owner will have little power over it once created 

• Is private access, in that participants can't see each other and can't subscribe to notifications 
(although owner/sender can) 

• Is represented in the VFS tab using the Subject line and the sender's username 

• Is represented differently in the WTC 

• Content gets deleted when it expires 

• Is more likely to have a shorter maximum expiration period than regular Workspaces 

• Supports self-expiring, single-use file links, which are not supported in regular Workspaces 

Upgrading the Web Transfer Client (HTML5 version) 

The HTML 5 version of the Web Transfer Client (WTC) has a separate upgrade wizard from EFT, so that you 
can upgrade the Web Transfer Client as changes are made available without reinstalling all of EFT. You can 
verify the current version by logging in to the WTC and clicking About. 
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To upgrade the WTC 

1. Copy the installer (eft-wtc-installer.exe) to the EFT computer and double-click it. The WTC 
upgrader installer opens. 

 
2. Click Next. The license agreement appears. 

 
3. Scroll to read the agreement, then click I Agree. The WTC is upgraded. 
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4. Click Show details to view the process of updating. 

5. After the upgrade is complete, click Close. 

Workspaces Conditions 

You can apply these Conditions to File Uploaded events. 

• If Workspace Physical Path - Tests whether the physical path does or does not match a path mask. 
Wildcards can be used. 

 
• If Workspace Virtual Path - Tests whether the virtual path does or does not match a path mask. 

Wildcards can be used. 
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• If Workspace Name - Tests whether the folder name does or does not match a mask. Wildcards can 

be used. 

 
• If Workspace Participants List - Tests whether the participant list does or does not contain a string 

specified. 
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• If Workspace Owner - Tests whether the Workspace Owner is or is not one of a list of specified 
users. 

 
• If Workspace Owner Email Address - Tests whether the Workspaces Owner email address does or 

does not contain or is equal to a specified string. 

 
Workspaces Invitations 

An EFT administrator can invite internal users to join existing Workspaces in the VFS tab. External users 
cannot be invited via the VFS tab; they can only be invited by email address in the Web Transfer Client 
(WTC). 

When a user is invited via the WTC, EFT follows the following logic flow: 
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1. EFT will first look for a matching email address in the existing Site user profiles and usernames. For 
example, let's say a Workspaces folder owner invites a user to share a folder with the email address 
test@gs.com. EFT will search for a user in the existing Site for either a username of "test@gs.com" 
or a username with an associated email of test@gs.com. If a match is found, then EFT sends an email 
to the invited user to let them know that they have been invited to share a Workspaces folder. 
Internal users are not invited, they are automatically joined. 

2. If more than one internal user is associated with the invited email address, either by username or 
profile e-mail address, EFT will decline to add the user. 

3. If the email address is not associated with any internal username or email profile and the Site-level 
Workspaces tab has the Allow invitation to new EFT users for Workspaces option enabled, then 
EFT will add the user to the Workspaces folder as a "pending" user, and the user will be invited to 
create an EFT account to gain access to the shared folder. However, if the option is not enabled, then 
the invitation request will be denied. 

Internal Users 

When adding participants to Workspaces folders, the email address is the unique participant identifier. 
Existing users will be added to a Workspaces folder only if there is one and only one match for the e-mail 
address being invited. Before completing an invitation, EFT will check both the username and email address 
fields for all users on the Site for matching addresses. 

• If two internal EFT users on the same Site have the same email address, they cannot both be 
joined to the same Workspaces folder. For example, if user accounts test2 and test3 each  have the 
email address user@gs.com, and the administrator attempts to add users test2 and test3 to a 
Workspaces folder, EFT will not permit test3 to join, and will state that it's due to duplicate users. In 
the WTC, the "Unspecified error has occurred" message will appear. If Workspaces trace level logging 
is enabled, then the log will report the offending email address. 

• If one user’s username is the same as another user account's e-mail address and a Workspace owner 
attempts to invite that address, an error will occur and the user will not be invited. 

Guest Users 

When guest users are invited to join a Workspaces folder, they must individually accept and activate each 
Workspaces invitation, then create an account to gain access to the Workspaces folder. 

• When guest users join a Workspaces folder, their user accounts are created under EFT's Guest User 
Settings Template. Guest users are permitted to create Workspaces, but cannot invite new guest 
users to share the folder. Guest users can only invite users who already have an EFT account. 

• The EFT VFS tab indicates which users are in the "pending" state, meaning they have not yet 
accepted their invitations. Once a user accepts an invitation, the "Pending" status is removed. Invited 
users have 5 days to accept and activate a pending invitation, after which the invitation will expire. This 
is a hard-coded value and cannot be modified. 
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• Workspace owners and EFT administrators are not notified when an user's invitation expires. When an 
invitation expires, the user is automatically removed from the Workspaces folder and no longer will 
appear as a pending user. There is no resend-invitation option. To re-invite a user whose invitation has 
expired, the Workspaces owner, via the WTC, has to re-invite the user, at which point the invited user 
will go back into a pending status and will again have 5 days to activate the account. Pending user 
status can only be viewed via the VFS Tab. 

• A guest account that has been disabled (e.g., due to the Workspace expiring) doesn’t automatically 
get re-enabled if a new invitation is sent to them. The EFT administrator must enable the account or 
remove it, and then the guest would have to recreate it. 

Workspaces Notifications 

When a Web Transfer Client user shares a folder, an invitation is sent to the user with whom the folder is 
shared. If the recipient does not have an account on EFT, the user can register the account. For invitations 
sent to non-EFT users, an email is sent to verify the account when the user registers the account. 

The text for the invitation and verification emails is contained in an HTML file that can be customized for 
localization or to provide company-specific information. 

 

Workspaces invitations expire after 5 days. 

The files are stored in the ProgramData directory (by default, C:\ProgramData\Globalscape\EFT Server 
Enterprise) and apply to all Sites on the Server. (The path is shown on the Server's General tab, under 
General Settings > Server configuration settings.) 

 
You can edit the files in any text editor. Note that the "WS" variables used in these notification templates are 
used only in these templates. They are not Event Rules variables. 

The files are named per their function: 

• WorkspaceNotification.txt - Used to notify the Workspace owner that a recipient took an action on a 
file. 
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• WorkspacesAdminAddedParticipantMsg.html - Used to notify recipients that a Workspace was 
shared with them. 

• WorkspacesInviteRegisterMsg.html - Used to notify recipients that a Workspace was shared with 
them and they are invited to register an account on EFT. 

• WorkspacesInviteVerifyMsg.html - Sent after recipient has registered for an EFT account and needs 
to verify the account. 

• WorkspacesOAIEmail.html - Notification to recipients that a file has been sent from Outlook. 

• WorkspacesOAIEmail.txt - Text version of the notification to recipients that a file has been sent from 
Outlook. 

• WorkspacesOAIEmailWithSecureMB.html - Notification to recipients that a file has been sent from 
Outlook with secure message body. 

• WorkspacesOAIEmailWithSecureMB.txt - Text version of the notification to recipients that a file has 
been sent from Outlook with secure message body. 

• WorkspacesRequestFileEmail.html - Notification to sender that a file has been requested. 

• WorkspacesRequestFileEmail.txt - Text version of the notification to sender that a file has been 
requested. 

To edit the Workspaces invite and verify messages 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Server node. 

3. In the right pane, click the General tab. 

4. In the General Settings area, next to Workspaces invite message, click the browse icon. Your 
default text editor (e.g., Notepad) opens with the invitation text. 
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Edit the text as needed, being careful not to delete the variables (%USER.EMAIL_ADDRESS%, 
%WS_OWNER_NAME%, %FOLDER_NAME%, %LINK%), then save the file and close the text 
editor. 

 

The WS_ variables are not Event Rule variables. To use 
Workspaces variables in Event Rules, refer to the 
Variables list. 

5. Next to Workspaces verify message, click the browse icon. Your default text editor (e.g., Notepad) 
opens with the verify text. 

 
6. Edit the text as needed, being careful not to delete the variables (%USER.EMAIL_ADDRESS%, 

%LINK%). 

7. Save the file and close the text editor. 

To create Site-specific versions 

(See also Specifying External and Internal Domains) 

1. Make a copy of the existing template. 

2. Make your edits (using a text editor, such as Notepad), being careful not edit any of the variables or 
necessary code. 

3. Save the edited version with the Site name and an underscore prepended to the front if the filename. 
For example, name it MyFrenchSite_PasswordResetMsg.html 

Workspaces Permissions 

Workspaces permissions are separate from the VFS permissions, such as those permissions for the Usr 
folders. Users who have Workspaces permissions on a folder will not appear in the VFS permissions for that 
folder. For example (as shown below): 
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1. "imauser2" has full permissions on the \Usr\imauser2\ folder in VFS. 

2. In Workspaces, "imauser2" has shared a folder called "folder 2" with "imauser1." 

3. When the administrator clicks "folder 2" in the Workspace Folder tree, you can see that "imauser1" 
has Workspaces permissions on that folder. 

4. However, only "imauser2" has VFS permissions on that folder. 

 

 
Specify Custom Default Workspaces Sharing Permissions 

By default, all Workspaces permissions are selected, and the user is expected to clear any permissions that you 
do want to give the invitee when a folder is shared. Alternatively, the EFT administrator can change the default 
permissions so that one or more permissions are NOT selected by default, and then the user sharing the 
folder has to explicitly enable the permission. Changing the defaults does NOT disable the permission; it 
simply is not selected by default. The sharing user can still enable it when inviting users to share a Workspace. 
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To specify default sharing permissions 

1. In C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\scripts, 
find the adminConfig.js file. (There is a number in front of the name.) 

2. Open the configuration file in a text editor, such as Notepad++. (It may be necessary to change the 
extension from JS to TXT to view it properly.) 

3. Look for the Default permissions section and the following text: 
gsb.config.defaultWSPermissions = { 
    canUploadFile: true, 
    canDownloadFile: true, 
    canDeleteFile: true, 
    canRenameFileFolder: true, 
    canCreateFolder: true, 
    canDeleteFolder: true 
}; 

4. For the permission that you do NOT want selected by default, change true to false, then save the file. 
For example, if you do not want the Delete File permission selected by default, change 
canDeleteFile: true to false. 

5. If you changed the name of the file to edit it, be sure to change it back. 

Workspaces Permissions on an Active Directory Site 

Workspaces has the ability to invite external users on an Active Directory Site. Described below is what occurs 
when a non-AD account has been invited to a Workspace, what permissions the EFT Server enforces for file 
activity, and how that applies to the "Comments" feature of Workspaces. This is important because the basic 
behavior of an AD Site, independent of Workspaces, is that any client that logs in as an AD account will 
subsequently access all files exposed by EFT's protocol engines using that very same AD account used to log 
in (known as "impersonation"). Thus, it is not EFT that enforces file system permissions to local and UNC 
paths; it is the Windows operating system. 

When EFT allows non-AD users to gain access to this Site (when we allow invitations to external parties) then 
we no longer impersonate an AD user and, therefore, our EFT application is limited in access by the service 
account under which it runs; however, this might be more permissive than the permissions for any individual 
user in the AD server. 

For example, suppose your organization's AD users have READ/WRITE access to everything on a shared 
drive, and have explicit DELETE permission to our own folder but no one else's folder. Suppose the IT 
administrator set up a Folder Monitor rule against the shared drive. The IT administrator would have to run the 
EFT service as an AD account that had READ/WRITE/DELETE permissions across the whole shared drive so 
that the Folder Monitor workflows can move or delete files, or so that the EFTArchive operation worked, and 
so on. 

Suddenly, there is a security concern: Any externally invited Workspace user will act against the shared drive 
the same as the EFT service account, not an individual AD account. 

https://notepad-plus-plus.org/download/v6.8.3.html
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THEREFORE¸ our application itself must impose permissions checks on all file access for such accounts 
(which, by the way, is exactly how LDAP, Local, and ODBC authentication work). 

EFT server will perform a permissions check on any assignment of Workspaces permissions to a participant 
(creation or modification time). EFT compares the OWNER permissions to the requested Workspaces 
permissions for a participant, and ensures at that moment that the OWNER does not grant MORE 
permission to a given folder than that which the owner of the folder holds. 

All file activity within a Workspace is managed by EFT to conform to ONLY those permissions allowed by the 
Workspace configuration. Therefore, EFT enforces that Workspace permissions are equal to or less privileged 
than the owner's permissions, regardless of the service account under which EFT operates. 

Below is a summary table that describes the permissions checks EFT applies to Workspace file and Comments 
activity for both OWNERS and for PARTICIPANTS upon adding or modifying participants in a Workspace: 

Operation on 
file or comments 

Required Owner EFT VFS 
permissions 

Required Participant Workspace 
permissions 

ADD PERMISSION_FILE_APPEND or 
PERMISSION_FILE_UPLOAD 

canUploadFile 

UPDATE PERMISSION_FILE_APPEND or 
PERMISSION_FILE_UPLOAD 

canUploadFile 

DELETE PERMISSION_FILE_APPEND or 
PERMISSION_FILE_UPLOAD 

canUploadFile 

GET PERMISSION_DIR_LIST N/A – Means that Participant can read 
comment because Owner invited them 
to Workspace. 

For example, for the invited user to be able to comments to files, *both* of the following conditions must be 
met: 

• Owner must have Append or Upload EFT VFS permission for that file. 

• Participant (invitee) must be granted the Upload Workspace permission by the inviter. 
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WTC & Workspaces User Guide 
The procedures for configuring and using the Web Transfer Client are described in the topics below. Refer to 
Web Transfer Client Administration for information about configuring the Web Transfer Client on EFT. 

Overview of the Web Transfer Client 

The Web Transfer Client (WTC) is a browser-based file transfer client that allows you to transfer files over 
HTTPS to and from a server. Using the WTC, you can upload and download files to the server, pause and 
resume a transfer, cancel a transfer, move files between folders, create, rename, and delete folders and files, 
and share folders with other users. 

 
   

Logging In 

You can log in to the WTC and Workspaces in any supported browser. The system administrator will provide 
you with the URL (web address) and your login information. 

To log in to the server 

1. Open the web browser. 

2. Type or click the web address provided to you by your system administrator. For example, type 
https://www.ourfileserver.com. The login page appears. 
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o If you don't know your username, click Forgot Username (if available). In the Lost 

Username dialog box, provide your email address and then click Submit. 
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o If you don't know your password, click Forgot Password (if available). In the Lost Password 

dialog box, provide your Username and Email address, then click Submit. 
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Your request is sent to the server and an automated response will email you your username. 

3. If you have been instructed to use secure sign-on, click SSO Login. 

4. Provide your Username and Password, then click Log In. 

5. If you have been instructed to use two-factor authentication, you will be asked to provide a second 
response, such as an RSA key. 

The EFT administrator can change the text that appears for the challenge. Refer to the article at 
https://kb.globalscape.com/KnowledgebaseArticle11267.aspx for details. 

6. When the credentials are accepted by the server, the Web Transfer Client (WTC) appears. 

Logging Out 

The server ends the session immediately when the browser is closed or after a period of inactivity. When the 
session is ended, the directory listing and any other personal information is cleared, and the login page is 
displayed. 

To log out 

• Click Account > Logout. The WTC closes and the Log In page appears. 

https://kb.globalscape.com/KnowledgebaseArticle11267.aspx
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Automatic Log Out 

After a period of inactivity (approximately 10 minutes), a message appears warning that you are about to be 
logged out. You can click Continue to stay connected. 

 
Add Workspace Participants 

After you have created a Workspace and invited participants to join the Workspace, you might later want to 
add participants. 

To add participants 

1. On the tool bar, click the Add participants icon . 

 
2. Provide one or more email addresses, assign permissions, then click Share. 
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Sharing Folders (Creating a Workspace) 

You can invite internal and external users to share your folders, if the EFT administrator enables and 
configures Workspaces to do so. To share folders, the administrator has to have enabled Workspaces in the 
EFT administration interface on the Workspaces tab of the Site. Workspace participants who were invited to 
share a Workspace cannot add participants to that folder. However, they can create new folders. 

The invitation recipient clicks the link embedded in the email and then signs in to EFT (if an account has 
previously been created), or creates an account on EFT. 

• Workspaces invitations expire after 5 days. 

• Administrators can see and manage invited (guest) accounts in the administration interface on the 
VFS tab. 

To share a folder 

1. Log in to the Web Transfer Client. 

2. Select the check box of the folder that 
you want to share, then click the Share 
Folder icon , or click File > Share 
Folder. The Create a Workspace dialog 
box appears. 

3. Provide up to 10 email addresses of users 
with whom you want to share the folder. 
(You can later add more participants, 10 
at a time. To add more than 10, the EFT 
administrator can edit the WTC files. 
Refer to the Knowledgebase for details.) 

4. To create a private workspace, select the 
Make this workspace private check box. 
When a Workspace is private, the 
Alerts/Notification icon, the Workspace 
participants icon, and the comments icon 
are hidden from the recipient. 

5. Assign permissions by clearing or 
selecting the check box next to that 
permission. By default, all permissions are 
selected (enabled). Clear the check boxes 
of the permissions that you do not want to assign to the users. 
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The administrator can specify which permissions check boxes are selected by default, if any. The sharing 
user can still select the check box to enable the permission. Refer to Workspaces Permissions for 
details. Permissions that the administrator assigns to folders override any permissions that you assign. 
That is, if the folder that you are sharing does not have rename permission, you cannot assign that 
permission to the folder. 

6. (Optional) In the Messages box, you can type comments. When you create a Workspace, the 
comment that you type in the Messages box appears in the invitation email. 

• View a history of comments added by clicking the shared folder and then clicking the 
comment icon. 

 
7. In the Notifications box, you can specify the type and frequency of email notifications about this 

Workspace. 

8. (Optional) To expire the Workspace, select the Workspace expiration check box, and then specify 
the expiration. The limit is specified in the administration interface on the Workspaces tab of the 
Site. (Alternatively, there is a Stop Sharing icon in the WTC toolbar.) The default expiration date 
appears, when defined in the administration interface on the Workspaces tab. 

9. Click Share. A banner appears at the top of the folder list indicating that you are sharing the folder as 
a Workspace. 
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The users with whom you have shared the folder will see the shared folder in their Shared with Me 
tree. The username of the account that is sharing the Workspace appears in parentheses after the 
name of the folder (e.g., EFTWebAdmin (Imauser1)). 

 
Stop Sharing a Workspace 

When you stop sharing a Workspace, the folder is removed from the Joined Workspaces tree. 

To stop sharing the folder 

1. Click the shared folder. 

2. Click the stop sharing icon in the banner . The Stop Sharing Workspace message appears. 
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3. Click Stop Sharing. 

Send/Email Files from within the WTC 

EFT users who want to add files that are either located in their local machine or are in the WTC can do so 
securely from within WTC. Recipients of those files can pick up the files in their default browser. 

• The browser will timeout after a period of inactivity. Files that are being uploaded are considered 
"activity." Idle timeout occurs if you leave the browser open and stop composing your message with 
no activity. Upon timeout, the draft is lost. An "about to timeout" warning prompt is displayed when 
timeout is imminent, giving you the opportunity to keep the session alive. 

• When you send a file using the WTC, a "WorkspacesSendMessage" folder is created in the Virtual File 
System (VFS). 

To email files 

1. Log into the WTC. 

2. Click the Send icon   on the toolbar. The Send files securely form appears. 
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3. The From box is a drop-down list if there is more than 1 email address for this user in EFT. 

4. Select the files that you want to send: 

 
5. To send the request securely, select the Send message body securely check box. 
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6. Specify message options. 

 
7. Under Delivery Notifications, specify if and when you want to be notified when your message is 

picked up. 
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8. Under Authentication & Authorization, specify whether an EFT account is required to pick up your 
message, and whether non-EFT users can reply to your message. The Allow non-EFT users to reply 
option is not available if reply is not allowed by administrator. 

9. Under Message Expiration Options, specify when you want the message to expire. 

10. Select the Save as defaults check box to use the same settings every time. (You can still edit them, 
as needed.) 

11. Click Apply, then click Send Message. A message appears indicating whether the message was sent 
successfully or not. 

 

The Not Sent message appears if you have EFT configured to send only to EFT users (most restrictive) 
and you try to send to non-EFT users. If you need to send to user accounts that are not defined in EFT, 
your EFT administrator will need to either change the setting on the Workspaces - Send tab of the 
EFT Site or add the account as an EFT user. 

12. If sending the message was successful, the recipient(s) receive an email with a link to pick up the files. 

Canceling a Transfer 

Most files that you transfer will transfer so quickly, you won't even notice. Larger files, however, will show 
progress in the In Progress area of the Upload Manager. You can cancel an in-progress transfer. 

To cancel a transfer 

1. In the Upload Manager, while the transfer is in progress, click the PAUSE icon. 
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2. After the transfer is paused, a Play and a Cancel icon appear. 

 
3. Click the Cancel icon to stop the transfer. 

Changing Your Password 

The administrator may have set your password to expire periodically. You can change your password within the 
Web Transfer Client. 

To change your password 

1. In the upper-right corner, click your login name (in versions prior to 7.4.11, click Account), then click 
Password. The Change Password dialog box appears. 

 
2. Provide your Old Password and New Password, and then Confirm Password. If the administrator 

requires complex passwords, a message will appear if your password does not meet the complex 
password or reuse password requirements. 

3. Click OK. 
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Clearing the Upload Manager 

The Upload Manager displays uploads that are completed, in progress, and pending. The pane will clear 
automatically when you log out of the Web Transfer Client. (Removing the list of files from the pane only 
removes it from the display; the file is still saved in the folder into which you transferred it.) 

To clear the Upload Manager 

 
After a transfer is completed, the file moves from the In Progress queue to Completed. Click the DELETE 
icon to remove all completed transfers from the queue. 

Creating Folders 

When you first log in to the Web Transfer Client (WTC), you are in the top folder that you are allowed to view, 
called your home folder. You can create sub folders within this folder, and those folders can have subfolders. 

To create sub folders 

1. In the Folders pane, click to select the folder under which you want to create a subfolder. 

2. On the toolbar, click the NEW FOLDER icon . 

3. Provide a name for the folder, then click OK. (Folder names follow standard Windows file naming 
conventions.) 

4. The new folder appears in the Folders pane. You can now move files between folders and upload files 
to the new folder. 

Deleting a Folder or File 

You can delete folders and files in your home folder and in subfolders. 

To delete a file or folder 

1. Select the check box for the file or folder that you want to delete. 

2. On the toolbar, click the DELETE icon . 

3. The Delete confirmation message appears. Click OK. 
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Using the Drop-Off Portal 

The Drop-Off portal can be used by external users to send files to internal users on demand (ad hoc), without 
creating user credentials. 

 

A Workspaces license is consumed for each Drop-off portal message no matter how many recipients the 
message has. A license is not consumed on replies. A license is not consumed on Send Portal messages. You can 
avoid Workspaces licenses being consumed by the Drop-off portal by disabling the Drop-off portal. It is not 
enabled by default. 
When someone uses the drop-off portal, that person becomes a "Workspaces owner." This is because behind the 
scenes, a temporary, anonymous account is created to host the Workspace, thus consuming a license (assigned 
to that account). Once the space expires, the anonymous account is also removed, and the license is released to 
the pool.  

To send a file using the Drop-Off portal 

1. In your browser, go to the URL provided. (Your administrator or internal user will provide the 
address.) The Drop-Off portal appears. 

 
2. The To box is not editable, unless the administrator has enabled it. If the To box is enabled, you are 

limited to addresses in the domains defined by the administrator or to lists defined in the EFT 
administration interface. 

3. In the From box, provide the email address at which you want to receive responses. 
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4. In the Subject box, provide a clear topic of the email. (i.e., "Files for Wednesday's Acme project 
meeting" is more clear than "The files you wanted.") 

5. In the Message box, provide a brief reason for the email. 

6. Drag and drop or select the files to attach to the email. 

7. To send the request securely, select the Send message body securely check box. 

8. Click Send Message. A confirmation message appears. 

9. If you want to send another file, click Send Another. 

• If the send was not successful, an error message appears. Click Try Again to verify the email 
address and resend the email. 

10. The recipient will receive an email with a download link. If the recipient has an account on EFT and 
signs in to the Pick-Up portal, the recipient can reply to the sender. 

Reply Portal 

After you have received a message sent through Workspaces, you can reply to the email (if so configured) and 
send files back. 

Reply and Reply All buttons are displayed under the following conditions: 

• For anonymous recipients, if the sender has enabled replies 

• For authenticated recipients:   

o if the Workspaces license limit is not exceeded 

o if Enable reply portal check box is selected (on the Site Workspaces-Send tab) 

o if Workspaces and Send Files are both enabled (at the Site level) 

• Reply All button is not displayed if sender is the only available recipient on the thread. 

• The alias name is displayed if any recipient is from an alias list 

To reply to the email 

1. The From, To, and Subject lines are completed for you. 
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2. Compose a Message, "drag and drop" or browse for files, then click Send Message. 

3. If the reply is in response to a request for files, an additional field appears: 

 
4. To send the request securely, select the Send message body securely check box. 

5. Complete the email and click Send Message. 

Picking Up Files 

After a Workspaces or EFT Outlook Add-In user sends one or more files, the recipients can click a link in the 
email that they receive that opens their default browser to the Workspaces Pickup portal. 

Depending on the administrator's settings, the files might be available for download only once, after which the 
download links will expire. 
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In earlier versions, the recipient email contained a link to the Pickup Portal and another single-click link to the 
file(s) sent. In this version, automatic file download was added to the Workspaces templates and direct download 
links were removed. If you have upgraded to EFT v7.4.9, the earlier templates were not overwritten. 

To download files in the Pickup portal 

• In the notification email, click the Workspace link. 

• The default browser opens to the Pickup portal. 

 
For replies to requested files, the following Pick Up portal appears. 
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Select one or more files and click Download Selected to download multiple individual files or click 
Download All to download all of the files. 

Downloading Files 

You can download files from the server to your local computer on which you have download permission. The 
mechanism for downloading files is browser dependent. This is, Internet Explorer, Google Chrome, and 
Mozilla Firefox each has its own mechanism for downloading files. 

 

• The HTML5 version of the Web Transfer Client does not support a CRC-check for downloaded files 
because of the limited access of html/js to the client file system. The process of initiating a download is 
human driven and can NOT be intercepted by a JavaScript API; it is wholly managed by the browser 
itself, for security reasons. Further, the browser cannot arbitrarily read files on the local file system (for 
obvious security reasons), so EFT cannot read contents of downloaded files to do CRC32, and thus 
cannot issue a follow-up HEAD request to verify the integrity of the download. 

• The default download timeout of 60 seconds can be increased if needed (as of v7.4.11). 

To download files 

• Do one of the following: 

o In the Pickup Portal, select the check box of one or more files that you want to download, 
then click the download icon   on the toolbar. The file downloads to the folder defined in 
your browser's configuration. (To open your browser's Downloads folder, see below.) 

- OR -  
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o In your browser, copy and paste the URL provided by your admin or in your company portal 
(e.g., https://workspace.mycompany.com/directdownload/foo/MetaData2.db), then press 
ENTER. (This option is often referred to as "directdownload" or "anonymous download.") 

a. Login. The Save As dialog box appears and the file downloads.  

 
b. Specify a location, if different, then click Save. 

To open your browser's Downloads folder: 

• In Chrome, click the Settings icon, then click Downloads (or press CTRL+J). 

 
• In Internet Explorer, click the Settings icon, then click View Downloads (or press CTRL+J). 
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• In Firefox, click the green down-facing arrow to view most recent downloads, or type 
about:downloads in the address bar to view all downloads. 

Uploading Files and Folders 

You can upload files and folders from your local computer to a remote server on which you have upload 
permission. 

To upload files between your local system and the server 

• Do one of the following: 

o To transfer files to the server, click File > File Upload. 

o To transfer folders to the server, click File > Folder Upload. 

 Folder uploads are available in Chrome, Firefox, or Opera browsers only. If you 
want to upload folders in other browsers, you must compress them (make a ZIP file) 
and upload the ZIP file. 

o Click and drag one or more files or folders from your local file system to the file list. (Empty 
folders will be ignored and not transferred.) 

o In the Upload Manager, click the UPLOAD icon, then select the files and folders that you 
want to upload. 

The File Name pane will refresh automatically after the upload is complete. 

The Upload Manager displays the completed transfers, in-progress transfers (up to 5 at once), and 
pending transfers. The Upload Manager is cleared when the session ends or you log out. 

 
• The PAUSE icon allows you to pause an in-progress transfer. If you want to clear the Transfer queue, 

you can click the CANCEL icon for each transfer or click the CANCEL icon at the top to clear all of 
the transfers. 
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Notes: 

• When the file is transferred, if there is a file with a duplicate name already in your folder on the server, 
the server will run a comparison on the contents. If the file contents are the same, the file is not 
uploaded. 

• You can upload multiple selected files at once by dragging and dropping from your local system to the 
WTC Upload Manager, or by clicking File > Upload and then selecting multiple files. 

• If you have exceeded your allowed disk quota on the server, a message appears when you attempt to 
upload more files. To continue to upload files, you must delete some of your old files from the server 
or ask your administrator to increase your allowed disk quota. 

• Before you can access the server using the WTC, the administrator must configure the server to allow 
WTC connections with your account. 

• If network connectivity is lost while the WTC is transferring files, you can retry transfers that 
previously failed or were incomplete. If a file partially transferred before the connection went down, 
the transfer will be resumed from the point that it left off. 

Resuming Transfers 

A file transfer can be interrupted for various reasons, such as a network glitch, or you might pause the transfer 
yourself. When a transfer is interrupted because of errors, it will resume automatically after network 
connection is reestablished (up to 10 retry attempts over a 5-minute period). 

To resume a paused transfer 

1. Transfers that have been interrupted appear in the In Progress queue. 

 
2. Next to the paused file, click the PLAY icon. The transfer will resume where it left off. 

Notifications 

Each Workspace participant can configure notifications to let them know when actions are performed on the 
Workspace, such as uploading or downloading. The notifications are set to Daily for all actions by default.  
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The Workspaces owner is notified when the specified actions occur, in the form of: 

[Folder name]: [Filename] was [action] by [user email address] from [user IP address] on [date] at [time]. 

e.g.: 
KB Templates: dmzgateway-help.jar was uploaded by kmarsh@mymail.com from 127.0.0.1 
on 12/4/2018 at  9:13:02 AM. 

  

To enable notifications 

1. Select the check box for the folder for which you want notifications. 

2. Click the notification icon (bell). The Edit Notification Options dialog box appears. 

 
3. Specify the notification frequency (the default is daily) and which actions to be notified about (all are 

selected by default). 

4. Click OK to save your changes. 
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Edit Notification Options 

When you create a Workspace, you can specify how often you want to be notified regarding actions taken on 
the Workspace, such as when files are uploaded to your Workspace. 

 
In the Notifications area, you can: 

• Receive an email immediately after every action is taken 

• Receive an email of all actions that were taken that day (sent at 12 am) 

• Never receive emails on actions taken. 

• Choose specific actions to be notified about, or none at all. 

If you later want to change your notification settings, you can do so in the Edit Notifications Options dialog 
box. 

To change notification options 

1. On the toolbar, click the notification icon .  The Edit Notification Options dialog box appears. 



72 

 
2. Make your changes and then click OK. 

Edit-Remove Workspace Permission 

The default settings for Guest Users include Download, Show this folder in parent list, Show files and 
folders in list. Users with whom a Workspace is shared do NOT have permission to move files and folders out 
of the Workspace. 

To edit a Workspace participant's permission or remove the user from the Workspace 

1. On the tool bar, click the Edit Workspace icon . 
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2. Do one of the following: 

• To delete the user, click the delete icon (trash can). 

• To edit the user's permissions, click the gear icon for the user that you want to edit, then 
make the changes to the user's permissions, as needed. 

3. Click OK. 

Error Messages 

Error messages and prompts appear for a variety of scenarios (e.g., if you attempt to upload a file whose path 
exceeds the Windows limit; attempt to create a folder when you do not have permission; the path exceeds the 
Windows limit; a folder with the same name exists; your disk quota is exceeded; and so on). If you have read 
the error message/prompt and are unable to resolve the error yourself, provide the text of the message to 
your system administrator. 

Expire a Workspace 

To expire the Workspace 

1. On the tool bar, click the Edit Workspace icon . 



74 

 
2. Specify the date that you want to expire the Workspace. 

3. Click OK. 

File Comments 

You can add and view comments on files in a shared Workspace. 

To view or add comments to a shared Workspace 

1. In a shared folder, select the check box next to a file. (NOTE: Clicking the file will attempt to open 
it.) The toolbar updates to show more options. 

2. With the file selected, click the Comments icon . The Comments dialog box appears. 

 
3. If no comments have been added, the Comments dialog box is blank. 
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4. To add comments, type in the text box, then click Save. 

 
5. The dialog box updates to display the comment, the username of the user who entered the 

comments, and the date and time the comments was added. 

6. Click the X in the top right corner to close the dialog box. (Cancel is used to clear a comment before 
you click Save. Once you click Save, the comment is added.) 

  

Filtering and Sorting the File Name Pane 

You can filter the display of the files to display only the files that you want, by name, file type, size, and/or date 
modified to limit the display to specific files and folders. Additionally, you can sort the File Name, Size, and 
Date panes by clicking the arrows in the pane header. 

To filter the File Name pane 

1. Click the funnel icon  in the header of the File Name, Size, or Date pane or next to the Search 
box. The Filter dialog box appears. 
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2. Provide filter criteria such as name, size, or date, then click Apply Filter. 

• To search for a specific size, click Greater than or Less than and provide a size to search for. 

3. To clear your filter and show all files, in the Filter dialog box, click Remove Filter. 

Joining a Workspace 

When a Workspace creator invites others to a shared folder, an email is sent to each invitee. 

To join a Workspace 

1. In the email invitation to join a Workspace (a shared folder), click View Folder (or right-click and 
then click Copy link address). The default browser opens with the WTC Registration page displayed. 
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2. Do one of the following: 

o Click Already have an account if this username is already registered. 

o Create and confirm a password to register this username. Verification instructions are sent to 
the email address. 

3. In the confirmation email, click Verify Account. The account verification process occurs, and then 
you can log in. 

4. The Web Transfer Client appears. You can see which folder was shared with you. The username of the 
Workspace creator appears next to the shared folder and in a banner above the folder list. 
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Logging Activity 

All activity in the client is logged in the server. You can view the log of events in the client and export the log 
to send to the administrator for troubleshooting. 

To view the log 

1. Click Tools > Log. 

The log appears: 



79 

 
To export the log 

1. Click the Export icon in the title of the log window. The log is exported to an HTML file in your 
browser. 

2. Click anywhere in the HTML page of the log, and then: 

o In a Windows operating system: Press CTRL+A to select all, then CTRL+C to copy the 
contents that are selected. Then, click in an email or text file and press CTRL+V to paste it 
into the email or text file. 

o In a Mac operating system: Press Command+A to select all, then Command+C to copy 
the contents that are selected. Then, click in the email or text file and press Command+V to 
paste it into the email or text file. 
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To change logging settings 

1. Click Tools > Log Options. 

The Log Options dialog box appears. 

 
2. The default logging level is INFO. to increase or decrease the level of logging, click the desired level. 

Not that each logging level will include the logging levels below it. For example, INFO includes all 
WARN, ERROR, and FATAL messages. 

o Click OFF if you want to turn logging off. It is a good idea to leave logging on at the default 
level in case of errors for which the administrator needs to review the logs. 

3. Click OK to accept your changes and close the dialog box. 

Moving Files between Folders 

After you have created subfolders in your home folder, you can move files between those folders. Users with 
whom a Workspace is shared do NOT have permission to move files and folders out of the Workspace. 

To move one or more files to another folder 

1. Select the check boxes of one or more files that you want to move, then click the MOVE icon . 

2. In the dialog box that appears, select the folder to which you want to move the file(s), then click OK. 
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• When moving large files, if a message appears saying that it failed to move the file(s), wait a 
minute to see if the file(s) appear in the folder.  

Renaming a File or a Folder 

You can rename folders and files in your home folder and in subfolders. The WTC follows Windows file-
naming conventions. That is, the following characters are invalid for file naming: 

< > : " / \ | ? * % 

To rename a file or folder 

1. Select the check box for the file or folder that you want to rename. 

2. On the toolbar, click the RENAME icon . 

3. The Rename dialog box appears. Provide a new name, then click OK. 

Request Files 

In the Web Transfer Client, a user can request files from another user, if Workspaces is enabled to send files. 

To request files 

1. Click the Request Files icon. 

 
The Request Files window appears, and the From address is completed for you. 

2. Provide the To address, Subject, and Message. 

3. To send the request securely, select the Send message body securely check box. 

4. Click Request Options. 

• To set message expiration, click the Message Expiration Options list and click an option: 

http://msdn.microsoft.com/en-us/library/aa365247.aspx
http://msdn.microsoft.com/en-us/library/aa365247.aspx
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You can set the message to expire immediately after first use, in 24 hours, in a week, or in a 
month. 

• Under  Authentication & Authorization Options, specify whether the recipient of the 
request must have an account or can be anonymous. 

 
5. Click Apply. 

6. Click Send Request. 

The recipient will receive an email similar to the one below: 
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7. The recipient should click the "click here" link to open the Reply portal in which the recipient can 
attach the requested files to send to the requestor, who can pick them up in the Pick Up portal. 

 
Searching for Files 

If you have a large number of files and subfolders, you can find file more quickly by using filters to search by 
name, size, or date, or typing text in the Search box to find the file. 

The Search box merely matches the text string that you type. For example, it doesn't know the difference 
between a PDF file and a PNG file (however, if you type png, the search results will show all files with png in 
the file name, including the extension). It is not case sensitive. Certain wildcards will return matching results. 
For example, w*n displays results that have a w, one or more other characters, and then an n, such as 
WEB_VPN_Instructions.docx and WindowsClustering.pdf. Wildcards are useful, for example, for finding files 
when you aren't sure how they were named. 

To search for files using a filter 

1. In the search box, type your search term in the box, and then press ENTER, or click the down arrow 
to do a global search. 

2. As you type, the WTC will find matches for what you have typed. 

 
3. Click the found item to navigate to it. 

https://support.office.com/en-US/Article/Examples-of-wildcard-characters-939e153f-bd30-47e4-a763-61897c87b3f4?ui=en-US&rs=en-US&ad=US
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4. Click the icon on the toolbar for what you want to do with the file (download, rename, delete, move, 
etc.). 

Unicode File Transfers 

EFT’s support for UTF-8 encoded Unicode characters extends to: 

Inbound protocols: 

• HTTP/S 

• SFTP 

Event Rules: 

• Copy/Move and Download action wizards (all protocols) when specifying "UTF-8" as the filename 
encoding, and when using wildcards for the source filename, e.g. (*.dat, or *.*) 

• Advanced Workflow Engine when passed filename-related context variables (e.g., %FS.PATH%, 
%FS.FILE_NAME%, etc.) 

Auditing: 

• EFT’s summary Client Log (CL) 

• EFT’s extended client logs (e.g. LAN copy, FTP extended, and SFTP debug logs) 

• EFT’s debug log (Log4Cplus) 

Exclusions*: 

• FTP protocol (inbound) 

• All Event Rule actions that process a filename related context variables (e.g. %FS.PATH%, 
%FS.FILE_NAME%, etc.); the only exception is Advanced Workflow Engine actions 

• Folder Monitor events. Windows will notify EFT when a Unicode file is dropped into a monitored 
folder, but EFT cannot (at present) pass the UTF-8 encoded filename context variable off to Event 
Rule actions for processing. The only exception being when the action is an AWE action, in which 
case UTF-8 encoding is preserved. Do not be tempted to use wildcards as the source filename for 
Folder Monitor rules (even if polling only is used), as this will lead to race conditions and other 
problems. Wildcards should only be used in rules that don’t use filename context variables, such as 
Timer, user, or system related events. 

• ARM database and all logs not explicitly mentioned above 

• No User Interface (UI) components. This means you cannot specify Unicode characters in Event 
Rules or anywhere else in the administration interface 

• No COM API support for Unicode 

• EFT does not support UTF-8 filenames over AS2 

*UTF-8 will be more comprehensive in a future version. Refer to Unicode Exceptions for more information. 
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Unicode FAQs 

The FAQs below are provided to answer questions you may have regarding EFT's Unicode support. 

Q. What is Unicode? 

A. Unicode is a standard that provides a unique number for every character, regardless of platform, program, 
or language. Systems that don’t support Unicode and without the proper ANSI code page will render 
characters such as 大きい魚  ???????.  or  �����. 

Q. Does EFT support Unicode? 

A. EFT partially supports Unicode and is moving towards full support. 

Q. What about UTF-8? 

A. UTF-8 is simply a popular mechanism for encoding Unicode characters using one or more bytes. Prior to 
supporting UTF-8, EFT used ANSI code pages to view filenames in the intended format (on the target 
system when browsing with the WTC or PTC). 

Q. What other mechanisms for encoding Unicode characters does EFT support? 

A. EFT uses full double byte UCS-2 encoding at the file system (I/O) level, UTF-8 encoding within EFT, and 
ASCII everywhere Unicode is not yet supported. 

Q. Does EFT support UTF-8 for file transfers? 

A. EFT preserves UTF-8 encoded filenames when transferring files over HTTP and SFTP when acting as a 
server, and over all supported protocols when acting as a client, when certain conditions are met (see next 
question). 

Q. What about EFT’s Event Rules? 

A. EFT’s Copy/Move and Download Action wizards (across all protocols) support Unicode when you specify 
“UTF-8” as the filename encoding method (radio button in the wizard), and when using wildcards for the 
source filename, e.g. (*.dat, or *.*). However, UTF-8 is not supported for these Actions if you use 
%FS.PATH% or any other variable for the source filename, which means the Folder Monitor Event cannot 
be used to offload files and conserve their Unicode format. In fact, the only Action that supports UTF-8-
encoded filenames through context variables is an AWE workflow task. 

Q. Which client applications can I use to see Unicode filenames when I transfer files to EFT? 

A. EFT's Web Transfer Client (WTC) supports UTF-8. For file transfer applications that do NOT support 
UTF-8, Unicode filenames will appear as "???????.exe" when using them to transfer files to/from EFT. 
CuteFTP v9 supports UTF-8. 

Q. Can EFT audit or log filenames or other data with Unicode characters? 

A. EFT’s summary Client Log (CL), extended client logs (LAN transfer logs, FTP logs, SFTP debug logs), and 
debug log (eft.log), and AWE’s logs all support Unicode characters. EFT’s EX logs, cmd out logs, and ARM 
(both auditing and reporting) do NOT support Unicode characters. 
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Q. If this filename: 梅雨右折車線_XYZ.ISO is transferred to EFT, how will it appear on disk? In 
reports? In EFT’s Event Rules? 

A. EFT will store the file to disk and conserve the original Unicode filename. The filename will be audited 
properly to EFT’s eft.log, but will be down converted to ASCII when audited to the EX log and to the ARM 
database, resulting in a filename that may look like this: ??????_XYZ.iso, which is also how it appears in 
EFT’s reports. The reason the last three characters and file extension are conserved is that UTF-8 and 
ASCII characters are identical for English characters (A-Z). So there is no loss of meaning (fidelity) after 
performing a UTF-8-to-ASCII conversion. This same UTF-8-to-ASCII conversion applies when EFT 
hands off the filename to the Event Rule dispatcher, except where an AWE action exists, in which case the 
filename context variable will retain the original UTF-8 encoded filename. Thus if data integration of UTF-
8 encoded filenames is needed, you should consider deploying AWE tasks alongside EFT’s Event Rules. 

Q How do Unicode filenames appear in EFT’s administration interface? 

A. EFT’s administration interface (AI) does not support Unicode characters. UTF-8 is always down converted 
to ASCII in the AI. This means you can’t specify a unique UTF-8 encoded filename in EFT’s offload wizard, 
a UTF-8 encoded username, path, or anything else for that matter. The ONLY way to process Unicode 
filenames in the Copy/Move and Download Actions is to use wildcards (*.*, *.dat, etc.) as the source 
filename, instead of using a specific filename such as梅雨右折車線.ISO. 

Q. Will Unicode encoded filenames be preserved in EFT Server’s context variables, such as 
FS.FILENAME or FS.PATH? 

A. Yes and no. For all Event Rule Events, Conditions, and Actions EFT will down convert the UTF-8 
characters into ASCII. The only exception is when those variables are passed to AWE. In that case alone, 
EFT conserves the UTF-8 encoded filename, so that AWE can consume the original UTF-8 encoded 
filename, as AWE is fully UTF-8 compliant. 

Q. Does EFT’s internal handling of the file differ depending on whether the file was received in ASCII 
or Unicode? 

A. In the guts of EFT it handles everything in Unicode. Conversion back to ASCII occurs only when working 
with a system or capability that doesn’t support Unicode. 
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File-Naming Conventions 

EFT follows the standard Windows naming conventions, with a few exceptions. (Please refer to Unicode File 
Transfers and Unicode Exceptions for details of using Unicode characters.) 

For example: 

• You can name files using almost any character for a name, except for the following reserved 
characters:  
< > : " / \ | ? * % 

• The maximum length for a path is 255 characters. This limitation includes the drive letter, colon, 
backslash, directories, subdirectories, filename, and extension. If the relative path is too long, a 
warning message appears. 

• Characters that are valid for naming files, folders, or shortcuts include any combination of letters (A-
Z) and numbers (0-9), plus the following special characters. 

^ 

& 

' 

@ 

{ 

} 

[ 

] 

Accent circumflex (caret) 

Ampersand 

Apostrophe (single quotation 
mark) 

At symbol 

Brace left 

Brace right 

Bracket opening 

Bracket closing 

$ 

€ 

= 

, 

! 

- 

# 

% 

Dollar symbol 

Euro symbol 

Equal sign 

Comma 

Exclamation point 

Hyphen 

Number sign 

Percent 

( 

) 

. 

+ 

~ 

_ 

Parenthesis opening 

Parenthesis closing 

Period 

Plus 

Tilde 

Underscore 

For more information regarding file-naming conventions, refer to the Microsoft Windows Developer Network 
article Naming a File and the Microsoft TechNet article How NTFS Works.  

http://msdn.microsoft.com/en-us/library/aa365247.aspx
https://technet.microsoft.com/en-us/library/cc781134%28v=ws.10%29.aspx
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Using EFT Outlook Add-In 
To use the Workspaces with Outlook, you must first install the EFT Outlook Add-In. You can use the 
deployment script available on the Workspaces OAI tab of the Site to deploy it to multiple computers at 
once in any deployment tool that you normally use, or you can install it with the EFT Outlook Add-In installer 
as described below. 

Before installing, refer to the system requirements. 

To install the EFT Outlook Add-In 

1. Get the installers from the installation folder (e.g., C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\OAI). 

• EFTOutlookAddinInstaller.msi - This is the main installer. 

• EFTOutlookAddinSetup.exe - This executable contains files that are needed by the main 
installer. 

2. Start the EFTOutlookAddinInstaller.msi installer and click Next on the Welcome page. 

3. Click Next. 

 
4. Specify the EFT Server Host (URL) and Port, then click Next. 



89 

 
5. Specify the location in which to install the Add-In, then click Next. 
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6. Specify the location to store temporary copies of attachments while they are processed, then click 
Next. 

7. Click Install. 

 
8. When installation is complete, click Finish. Outlook is launched. 

9. In Outlook 2013 and 2016, the Choose Profile dialog box appears. 

 
10. Specify which profile you want to configure for use with the EFT Outlook Add-In, then click OK. 

11. When Outlook opens, it will ask if you want to install the Add-In. Click Yes. 

12. If there are issues with the EFT SSL certificate, you will be ask if you want to accept it. Click Yes. 
(Clicking No will disable the Add-In.) 

The EFT Outlook Add-In options appear on the menu and in new emails. 
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EFT Outlook Add-In Interface 

The EFT Outlook Add-In allows you to send files from Outlook for pickup via a secure link. 

When the user interface is enabled, the EFT Outlook Add-in options are available in Outlook: 

 
When you create a new email, the EFT Outlook Add-In options appear: 

 
• If the EFT Outlook Add-in does not appear in Outlook, refer to Enabling or Disabling the Outlook 

Add-In. 

• If the EFT Outlook Add-in options are grayed out, check the following: 

o The account used to connect to EFT is not valid. Be sure that an EFT user account is used to 
connect to EFT. 

o The Add-in is unable to communicate with the EFT server. This could be caused by a number 
of issues, including incorrect connection information, invalid or blocked user account, or 
blocked IP address from multiple invalid connections. 

o Outlook Add-in is disabled in Outlook or in EFT. 

  

Changing the Message Format in Outlook 

RTF-formatted messages are not supported. The procedures below describe how to change the message 
format, depending on your version of Outlook. 
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Changing the Message Format in Outlook 2010 and later 

To change the message format for all messages 

1. Click the File tab. 

2. Click Options. 

3. Click Mail. 

4. Under Compose messages, in the Compose messages in this format list, click HTML or Plain 
Text. 

To change the format of an individual message 

1. With the message open, click Format Text. 

2. On the Format tab, click the format you want to use (Plain Text or HTML). 

Changing the Message Format in Outlook 2007 

To change the default message format for all messages 

1. On the Tools menu, click Options, and then click the Mail Format tab. 

2. In the Compose in this message format list, click HTML or Plain Text. 

To change the format of an individual message 

1. With the message open, click Options. 

2. On the Format tab, click the format you want to use (Plain Text or HTML). 

Connecting to EFT from Outlook 

Typically, the EFT Outlook Add-In server connection information is configured by the administrator. You 
should not edit these settings unless directed to do so by your administrator. Reasons why you might want to 
edit these settings are if your username/password has changed, if the server is moved to another host, if your 
login type was changed, or if you need to change the log file location. 

If the EFT Outlook Add-In is not connected to the server, it will not try to upload packages. 

In the General Configuration dialog box, accessed from the EFT Outlook Add-In toolbar/ribbon, you can 
specify to which server you want to connect, how to authenticate your connection, and where to save log files. 
In most cases, your administrator will configure this for you during setup. 

To configure the EFT Outlook Add-In 

1. On the EFT Outlook Add-In toolbar/ribbon, click General Configuration. The General 
Configuration dialog box appears. 
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2. In the EFT Server Host box, provide the host name of EFT. 

3. In the Port box, provide the port used by EFT for HTTPS connections. 

4. In the Authentication type box, specify either manual or Windows authentication: 

• Manual—You must provide the username and password that you use to connect to EFT or 
your AD credentials. 

a. In the Username box, provide the username that you use to connect to EFT or your 
AD username. 

b. In the Password box, provide the password that you use to connect to EFT or your 
AD password. 

Use the EFT login credentials for the EFT user account, not the administrator. 

• Integrated Windows Authentication—Used this login type if you connect to EFT via Single 
Sign On (Kerberos). In this case, you do not need to provide a username and password. Your 
Windows credentials are used to connect. 

5. If you want to test your connection, click Test Connection. 

6. (Optional) In the Log file location box, specify the path at which the log file is saved. 

7. Click OK to save your changes, or click Cancel if you do not want to save your changes. 
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Configuring Message Options in Outlook 

You can configure message options for all e-mails or for a specific email. In each email that you send, you can 
specify message options that pertain to that email only, overriding the default send options. You can make 
these settings stricter, but not less strict. Each procedure is described below. 

Use the Message Options dialog box to specify whether the EFT Outlook Add-in should: 

• Expire links 

• Use authentication 

• Notify on pickup 

• Manage embedded attachments 

• Queue or send emails when EFT is not available 

To configure message options to apply to ALL e-mails 

1. On the EFT Outlook Add-In toolbar/ribbon, click Message Options. The Message Options dialog 
box appears. 

 
2. On the Default Send Options tab, specify expiration, authentication, and notification options. 

3. If you want EFT to manage embedded attachments, such as a signature logo, select the Manage 
embedded attachments check box. 

4. On the Offline behavior tab, specify the following options: 
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• Queue e-mails until EFT server is available—Emails are sent after EFT server becomes 

available. 

• Send emails via Outlook without EFT Outlook Add-in—Emails are sent immediately, but 
not managed by EFT. 

• Prompt me for desired behavior—Display a prompt when EFT is not available so you can 
choose whether to send immediately or hold the email until EFT is available. 

5. Click OK to save your changes, or click Cancel if you do not want to save your changes. 

To configure send options for a specific email 

1. Create the email as you normally do. 

2. In the EFT Outlook Add-In area, click the options you want to change just for this email. 

3. In the Send Options dialog box, you can specify the following options: 

• Offload attachments—Embedded attachments are files that are inserted into the body of 
the email rather than attached to the email, such as a company logo in an email signature or a 
picture. If you want to make these embedded attachments into file download links, select the 
check box. (Cleared by default.) 

• Expire File Links—When selected, the ability to download the attachments will expire in the 
time that you specify. If the recipient attempts to download a file that is past its expiration 
date, the following message appears: “The file you are attempting to download has expired. 
Please contact the sender if this file needs to be resent.” (Cleared by default.) 
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• Authentications—Require the user to log in to download an attachment from the Pick-up 
portal. Selecting this check box helps prevent unwanted downloads from email forwarding 
and such, and also helps guarantee that the person downloading the file is the intended 
recipient. 

o If the user clicks on an individual file link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, the "open/save" 
dialog appears. 

o If the user clicks on the Pick-up portal link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, they will be 
taken to the Pick-up page for that specific package. 

o When the check box is selected, only the Pick-Up page link is sent. If the check box 
is not selected, individual links for each file are included in the email. 

The authentication will be saved in their session, so clicking multiple individual file links will not 
require multiple log-ins. (The session length is 10 minutes.) 

• Notifications—When selected, download notification is sent to you when the recipient clicks 
the download link in the email or Download Files on the Pick-Up page. 

4. Click OK to save your changes or Cancel if you do not want to save your changes. 

Enabling or Disabling the Outlook Add-In in Outlook 

If the EFT Outlook Add-In options do not appear in Outlook you need to enable it. Or in the rare instance of 
an error, you may you need to disable the Outlook Add-In or reenable it. 

To enable or disable the Outlook Add-In 

In Outlook 2010 - 2016: 

1. Click File > Options. 

2. In the left pane, click Add-Ins. 

3. In the Manage box, click COM Add-Ins, then click Go. The COM Add-Ins dialog box appears. 

4. Select (turn on) or clear (turn off) the EFT Outlook Add-In check box, then click OK. 

Take note of the state of the Add-In in the Trust Center (i.e. Active, Inactive, or Disabled). If the 
Add-In is in a disabled state, it cannot be enabled using the steps above initially. Instead, you must 
perform the following steps in the Trust Center: 

a. Next to the Manage box, click Disabled Items, then click Go. 

b. In the Disabled Items dialog box, click EFT Outlook Add-In, then click Enable. 

c. Close the Disabled Items dialog box. 
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If the Add-In now appears in the Active list, it is enabled. If the Add-In appears in the Inactive list, 
follow steps 3-4 above. 

In Outlook 2007: 

1. Click Tools > Trust Center. 

2. In the left pane, click Add-Ins. 

3. In the Manage box, click COM Add-Ins, then click Go. The COM Add-Ins dialog box appears. 

4. Select (turn on) or clear (turn off) the EFT Outlook Add-In check box, then click OK. 

Take note of the state of the Add-In in the Trust Center (i.e. Active, Inactive, or Disabled). If the 
Add-In is in a disabled state, it cannot be enabled using the steps above initially. Instead, you must 
perform the following steps in the Trust Center: 

a. Next to the Manage box, click Disabled Items, then click Go. 

b. In the Disabled Items dialog box, click EFT Outlook Add-In, then click Enable. 

c. Close the Disabled Items dialog box. 

If the Add-In now appears in the Active list, it is enabled. If the Add-In appears in the Inactive list, 
follow steps 3-4 above. 

Enabling Outlook's Language Detection 

The EFT Outlook Add-In uses Outlook's proofing language detection to determine in which language an email 
is written. If you want to enable the Auto detect email language setting, you must enable Outlook's Detect 
language automatically proofing setting. 

Before Outlook's Detect language automatically option can detect the language that you are typing and 
enable the proofing tools for that language, you must turn on the language-specific options you want to use. 

To turn on language specific options 

• For Microsoft Office 2007, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-
HA010243503.aspx. 

• For Microsoft Office 2010 and later, refer to the Microsoft Office article at 
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-
office-programs-HA010354783.aspx. 

To enable Outlook's Detect language automatically proofing setting 

• For Outlook 2007, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/turn-on-automatic-language-options-HA010244823.aspx. 

• For Outlook 2010 and later, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx. 

http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010354783.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010354783.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010244823.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010244823.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx
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From the Microsoft Office links above: "Automatic language detection does not work on a single-word basis, but 
on a sentence basis. Depending on the length of your sentences, you might need to type several sentences before 
Outlook has enough contextual information to automatically detect the language and apply the correct 
dictionary." 

Outlook must be restarted for the changes to take effect. After you have turned on the language-specific 
options in Microsoft Office and enabled Outlook's Detect language automatically proofing setting, then the 
Add-In's automatic language detection feature will be enabled. 

Mail Profiles with Multiple Accounts 

Outlook 2007 supports a maximum of one mail account per mail profile. As such, the Outlook Add-In for 
this version of Outlook supports a mail profile with a single mail account. 

Outlook 2010 and later supports mail profiles with multiple mail accounts. The Outlook Add-In seamlessly 
works with this new feature and (from a user standpoint) there is no real difference in how the Add-In is used. 
Emails with attachments can be sent from any of the mail accounts in the profile and the Add-In will manage 
the emails that meet the policy criteria, as usual. If an email is sent with the download notification feature 
turned on, the notifications will be sent to the account from which the email was sent. The Status pane will 
show an aggregated view of all packages that are being managed by the Add-In for all accounts. If an account 
is disconnected from its mail server, the Add-In will wait until connectivity is re-established for that account 
before uploading commences. 

The Outlook Add-In is supported with the following mailbox types: 

• Outlook 2007 supports a single MAPI or POP (not both at the same time) 

• Outlook 2010 and later support MAPI and POP 

Outlook Activity Reports 

With the Auditing and Reporting module, EFT provides reports of Outlook Send, and Outlook Pickup 
activities. 

 



99 

 
Refer to Reporting for information about reports. 

Recovering an Email from "Unrecoverable Error" 

The Add-In will try to automatically recover from problems such as loss of connectivity with EFT during a 
transfer. If the Add-In experiences an “Unrecoverable Error” while managing a package, the Recover Email 
button appears. An unrecoverable error is a more serious error that the Add-In cannot resolve on its own, 
such as a file system error caused by EFT running out of disk space. These types of errors will usually require 
an administrator to resolve. 

 
If you click Recover Email, the Add-In will move the email corresponding to the package from Outlook’s 
Outbox to the Drafts folder. You can then try resending the email, perhaps after the administrator has had a 
chance to resolve the issue. If the problem cannot be resolved in a timely fashion, but you need to send the 
email promptly, you can stop the Add-In from managing emails by turning it off via the Outlook Trust Center. 

• To turn off the Outlook Add-In, refer to Enabling or Disabling the Outlook Add-In. 

• To edit message options, refer to Configuring Message Options. 
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Sending Files with the Outlook Add-In 

If you have ever sent an email with attachments, you already know how to use the Outlook Add-in. Create the 
email, attach one or more files to the email, then click Send. You will continue to send and receive emails as 
always; the only difference is that the Outlook Add-in works transparently in the background to transfer the 
emails that have attachments. 

• The sent email is still saved to your Sent Items folder, but the attachments, if managed by the 
Outlook Add-in, are not saved in the Sent Items folder. Instead, a link to the attachments is added to 
the body of the email. The email saved to your Sent Items folder looks the same as the recipient's 
received email, minus the attachments. 

• The attachment and message, if managed by the Outlook Add-in, is saved on EFT in the location 
specified during installation, in a unique folder for each email, not on your SMTP server (such as 
Microsoft Exchange). 

• The Outlook Add-in stores information about emails that it is processing in an individual workspace. 

• The administrator configures message-sending options on EFT. You can configure more strict 
options in Outlook for all messages or for specific messages. Refer to Configuring Message Options 
for details. 

Sending the email can fail in the following situations: 

• Offline mode—Messages are stored in the outbox until Outlook is online and the Add-In connects 
to the server. 

• Loss of connectivity to the server—Interrupted uploads due to loss of connectivity to the server are 
continued from the point at which they were stopped when connection to the server is re-
established. 

• Insufficient disk space—The Add-In will receive a FileSystemError response from the server and the 
Add-In will treat this as an unrecoverable error. 

• RTF-formatted emails—RTF-formatted messages are not supported. To change the format for all 
messages sent in Outlook, refer to Changing the Message Format. 

To send a file 

1. Create an email as usual. 

2. Attach the file to the email using the EFT Outlook Add-in Offload Attachments button. 
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3. (Optional) Click one or more of the following options: 

• Secure Message—To send the email and its attachments as a secure message, click Secure 
Message. The attachment(s) and message body will be available to the recipient(s), through 
a secure Pick-Up portal. A unique message containing a unique link is created for each 
recipient. 

• Expire File Links—When selected, the ability to download the attachments will expire in the 
time that you specify. If the recipient attempts to download a file that is past its expiration 
date, the following message appears: “The file you are attempting to download has expired. 
Please contact the sender if this file needs to be resent.” 

• Authentications—Require the user to log in to download an attachment from the Pick-up 
portal. Selecting this check box helps prevent unwanted downloads from email forwarding 
and such, and also helps guarantee that the person downloading the file is the intended 
recipient. 

o If the user clicks on an individual file link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, the "open/save" 
dialog appears. 

o If the user clicks on the Pick-up portal link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, they will be 
taken to the Pick-up page for that specific package. 

o When the check box is selected, only the Pick-Up page link is sent. If the check box 
is not selected, individual links for each file are included in the email. 

The authentication will be saved in their session, so clicking multiple individual file links will not 
require multiple log-ins. (The session length is 10 minutes.) 

• Notifications—When selected, download notification is sent to you when the recipient clicks 
the download link in the email or Download Files on the Pick-Up page. 

4. Click Send. The email the recipient will receive a delivery notification. 
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5. The recipient can download the attachment "package" from the Web Transfer Client. 

 
6. If the attachment does not appear, the recipient might need to click the refresh icon. Select the 

check box next to the file, then click the Download icon. The file is saved to the recipient's browser 
downloads folder. 

Viewing Add-In Status 

The EFT Outlook Add-In includes a Status pane through which you can view whether you are connected to 
EFT and the status of email attachments being sent. By default, the Status pane is hidden. The pane appears 
on the right side of the main Outlook window. 

To view EFT Outlook Add-in status 

• On the EFT Outlook Add-In toolbar/ribbon, click Display Status. The EFT Outlook Add-in 
Status pane appears. 
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o The General Status area displays the status of your server connection. If the Outlook Add-

In is not connected to the server, it will not try to upload packages. 

o The Transfer Status area displays the status of attachments being sent, including recipient, 
subject line, size of the file, status (Pending, Transferring, Verifying File Digest, etc.), and the 
number of upload attempts. 

o To dock or undock the Status pane 

 Click and hold the title bar of the Status pane until the Move cursor  appears (or 
click the down arrow on the title bar of the pane, then click Move) then drag the 
pane to undock it and move it where you want. 

 To dock the pane, click in the title bar, and drag the pane back to the right or left side 
of the primary Outlook window. 

 To resize the pane (when undocked) click and hold a corner of the pane (or click the 
down arrow on the title bar of the pane, then click Size), then drag the pane to the 
size you want. 

o If the upload failed, the Transfer Status area displays the following information: 

 Text-based description of current status, including information on what prevented 
package from being uploaded in error cases 
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 Subject of the package 

 Recipients of the package 

 Total size of package 

 Number of upload retry attempts for package 

 Recover Email button for failures that were the result of an unrecoverable error. 
Clicking Recover Email moves the email to the Outlook Drafts folder. 
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